TWEAT '95
User's Documentation Update

B. Robertus
R. Lambert

March 1996

Prepared for the U.S. Department of Energy
under Contract DE-AC06-76RLO 1830

Pacific Northwest National Laboratory
Operated for the U.S. Department of Energy
by Battelle Memorial Institute

DISTRIBUTION OF THIS DOCUMENT IS UNLIMITED.
TWEAT '95 User’s Documentation Update

B. Robertus
R. Lambert

March 1996

Prepared for
the U.S. Department of Energy
under Contract DE-AC06-76RLO 1830

Pacific Northwest National Laboratory
Richland, Washington 99352

Reprint of historical document PVT D C95-02.04B (C95-04.01E.31.60C. Rev. 0), dated July 1995. Data, formatting, and other conventions reflect standards at the original date of printing. Technical peer reviews and editorial reviews may not have been performed.
DISCLAIMER

This report was prepared as an account of work sponsored by an agency of the United States Government. Neither the United States Government nor any agency thereof, nor Battelle Memorial Institute, nor any of their employees, makes any warranty, express or implied, or assumes any legal liability or responsibility for the accuracy, completeness, or usefulness of any information, apparatus, product, or process disclosed, or represents that its use would not infringe privately owned rights. Reference herein to any specific commercial product, process, or service by trade name, trademark, manufacturer, or otherwise does not necessarily constitute or imply its endorsement, recommendation, or favoring by the United States Government or any agency thereof, or Battelle Memorial Institute. The views and opinions of authors expressed herein do not necessarily state or reflect those of the United States Government or any agency thereof.

PACIFIC NORTHWEST NATIONAL LABORATORY
operated by
BATTelle
for the
UNITED STATES DEPARTMENT OF ENERGY
under Contract DE-AC06-76RLO 1830

Printed in the United States of America

Available to DOE and DOE contractors from the
Office of Scientific and Technical Information, P.O. Box 62, Oak Ridge, TN 37831;
prices available from (615) 576-8401.

Available to the public from the National Technical Information Service,
U.S. Department of Commerce, 5285 Port Royal Rd., Springfield, VA 22161
Welcome to...

TWEAT '95
Ternary Waste Envelope Assessment Tool

For the Glass Envelope
Definition Study of the PNL
Vitrification Technology
Development Project

prepared by Pacific Northwest
Laboratory, Richland, WA and
*Ariel Publishing, Inc.,
East Wenatchee, WA

Now with Binary Plots
and
Nonlinear Models

User's Documentation Update

Bob Robertus
Ross Lambert*

July 95
Disclaimer

This document is made available to the U.S. Department of Energy and its contractors in confidence solely for use in performance of other work under contracts with DOE. This document is not to be published or referenced in other publications, nor its contents otherwise disseminated or used for purposes other than specified above, without determination of final review authority. If the information contained herein is incorporated in any other documents, such documents shall receive appropriate Pacific Northwest Laboratory and DOE clearance.

Work performed on this activity was done to PNL QA level III standards.
Foreword

The purpose of the Ternary Waste Envelope Assessment Tool (TWEAT) is to graphically display the effects of glass composition on glass properties. TWEAT is designed to display on a ternary or binary diagram a "region of acceptability" for processing user-specified compositions of waste, frit, and (optionally) recycle subject to user-specified property limits. Single component crystallinity constraints can also be displayed on ternary and binary diagrams. TWEAT can generate property values for any selected point on either diagram. Tools are also available to display the boundaries of the experimental data over which the models have been developed.

TWEAT can be used in the PNL Vitrification Technology Development Project to help decide if selected combinations of waste, frit and (optionally) recycle streams will produce a glass melt and final glass product that meet specified processing and durability criteria. TWEAT is currently a useful tool for glass design activities. With minor modifications, TWEAT can provide valuable input for Low Level Waste glassification efforts whether done by Hanford or through privatization.

The largest effort in FY '95 was devoted to updating the models in TWEAT to non-linear ones as found in the Composition Variability Study (CVS)-II Phase 3 work. The solution/plotting algorithms were designed to be general so that second-order, temperature dependent, or other expressions yet to be developed could be displayed by TWEAT with minimal internal code revisions. These general plotting algorithms currently apply to the binary window only.

The binary window and it's associated input/output screens were created to answer user criticisms that the only valid part of the Ternary diagram was the Waste/Frit axis. Addition of the Binary plotting capabilities provides a tool which is now more useful to the glass formulation activities.

Another focus of FY '95 development was the interface between the Macintosh based TWEAT and the Sun SparcStation based Optimal
Waste Loading (OWL) environment (developed using the General Algebraic Modeling System (GAMS) software published by Scientific Press). The interface allows electronic transfer of the results of an OWL calculation to TWEAT. The information transferred includes composition of the waste, frit and (optional) recycle streams as well as the constraints OWL used to reach its optimum point. Finally, the fractions of waste, frit (and recycle) determined by OWL are included. All of this information is read into TWEAT and displayed on the appropriate diagram using the single TWEAT command 'import OWL Data'. This new combination of OWL and TWEAT '95 is a powerful tool for formulating frits to combine with wastes and/or waste blends.

The final activity for FY'95 was preparing this letter report.

These efforts satisfy the statement of work for this activity.
Acknowledgments

The authors of TWEAT gratefully acknowledge the technical efforts and contributions of the following individuals:

- Don Larson for programmatic guidance,
- Mark Hoza for generating the OWL test data, and
- Trish Redgate for generating the property models and uncertainty information.
## Contents

**Foreword** ................................................................................................................................................ iii

**Acknowledgments** ......................................................................................................................................... v

1.0 Introduction .............................................................................................................................................. 1-1
   - Purpose of TWEAT Update ...................................................................................................................... 1-2
   - Development and Application Status ...................................................................................................... 1-3

2.0 What’s New (and some review) ............................................................................................................ 2-1
   - Theory of Operation (binary mode) ......................................................................................................... 2-1
   - Select Constraints .................................................................................................................................... 2-4
   - Additional Tools ........................................................................................................................................ 2-7
   - Calculating Properties at a Point ........................................................................................................... 2-9
   - Composition Boundaries .......................................................................................................................... 2-10

3.0 Menu Reference ........................................................................................................................................ 3-1

4.0 Window Reference ..................................................................................................................................... 4-1

5.0 Reference .................................................................................................................................................. 5-1

Appendix A: Property Models ...................................................................................................................... A-1
   - Property Model Formulations .................................................................................................................. A-1
   - Coefficients for Property Models ........................................................................................................... A-4
1.0 Introduction

The user assumes all risks in using this application. The code is not verified and not validated. Software control procedures have not yet been implemented.

This report is designed to be a supplement to TWEAT '94 (PVTD-C94-05.01K Rev. 1). It is intended to describe the primary features of the Ternary Waste Envelope Assessment Tool software package that have been added in FY '95 and how to use them. It contains only minimal duplication of information found in TWEAT '94 even though all features of TWEAT '94 will still be available. Emphasis on this Update is the binary plotting capability and the OWL Import modifications. Like its predecessors, this manual does not provide instructions for modifying the program code itself.

The user of TWEAT '95 is expected to be familiar with the basic concepts and operation of the TWEAT software as discussed in TWEAT' 94.

Software and hardware requirements have not changed since TWEAT '94. TWEAT has now been tested using Macintosh System software versions 6.05 through 7.5.
The purpose of TWEAT update
Development and Application Status

The development of the binary property window required (for ease of use and understanding) modifications to the Vertex Data Entry window and all of the output windows. The new versions are in addition to the old ones. All of TWEAT '94 capabilities will be retained.

TWEAT is no longer limited to displaying only glass property models that are linear functions of glass composition. On the binary diagram any form of property model can be used so long as it is mathematically expressible in terms of the standard 10 oxide categories. Work has started on getting nonlinear models implemented on the ternary diagram. The technical (programming) complexities of using nonlinear models on a ternary diagram are nontrivial and could not be completed in FY 95. To avoid confusing the user (by showing nonlinear models on the binary plots and linear only on the ternary plot) display of the ternary plots is temporarily disabled in TWEAT '95. When the algorithms for plotting general order models on the ternary diagram are completed, the user will be able to switch freely between binary and ternary modes.

TWEAT '94 was shown to be a valuable companion to mathematical optimization algorithms which maximize waste loading by adjusting frit compositions to satisfy a specified set of glass property constraints. The Optimal Waste Loading (OWL) program is a customized application created at PNL to study various aspects of generating glass from Hanford wastes. TWEAT added value to the optimization results by displaying the "optimal waste loading" point on the ternary diagram. The exercises showed some optimal frits to be impractical because too many glass property constraints were approached simultaneously. In TWEAT '95 a new OWL import file was created to allow presentation of optimization results in either a 2-dimensional or a ternary diagram. Logic inside TWEAT determines which plot is appropriate based on OWL's output file.
2.0 What's New (and some review)

Theory of Operation (binary mode)

At its simplest, TWEAT takes a given glass composition and plots the value of at least one property constraint of that glass on a binary diagram. The compositions of the glass formers are supplied by the user and the property constraints to plot are selected from a list (actually the same list as for the ternary diagram).

There are therefore at least two windows to navigate before a binary diagram can be generated; the user must specify the composition of the waste and frit and also select at least one constraint.

The program initially defaults to an NCAW waste stream, plus a compatible frit. This allows first-time users to quickly generate a binary diagram and explore the effects of changing constraints or stream compositions.
The Edit menu commands Revert Field to Defaults, Revert Column to Defaults, and Revert Window to Defaults perform each of those actions respectively. These actions effectively restore the defaults just as they do in the ternary case.

<table>
<thead>
<tr>
<th>Edit</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Can’t Undo...</td>
<td>%Z</td>
</tr>
<tr>
<td>Cut</td>
<td>%X</td>
</tr>
<tr>
<td>Copy</td>
<td>%C</td>
</tr>
<tr>
<td>Paste</td>
<td>%U</td>
</tr>
<tr>
<td>Clear</td>
<td></td>
</tr>
<tr>
<td>Select All</td>
<td>%A</td>
</tr>
<tr>
<td>Revert Field to Defaults</td>
<td>%F</td>
</tr>
<tr>
<td>Revert Column to Defaults</td>
<td>%Y</td>
</tr>
<tr>
<td>Revert Window to Defaults</td>
<td></td>
</tr>
<tr>
<td>Preferences...</td>
<td></td>
</tr>
</tbody>
</table>

These same three commands are also available from the toolbar at the top of the Vertex Data Entry window (shown below). The gray shaded portion of each icon indicates the extent of the changes selecting it will make.

Tabbing away from the current field also illustrates another point: TWEAT recalculates the column totals whenever you move from field to field. You can also force a recalculation by selecting Recalculate from the Tools menu, or selecting the recalculation button in the toolbar.

The Tools menu has been modified to be a cascading menu. This clarifies for the user where the tools are applicable. Under the vertex data entry tool is a sub-menu of tools applicable to the Vertex Data Entry Window. The Calculate Other Oxides and Normalize Vertex Data tools are useful when the raw data being input do not exactly sum to 1.0000.

The Calculate Other Oxides tool notes the current sum and then
adds or subtracts an appropriate amount to the "Other Oxides" field to make the sum 1.0000.

The Normalize Vertex Data tool forces the total to 1.0000 by dividing each vertex entry by the sum that existed when the tool was invoked. Note that the tools act only on one vertex at a time and not the entire window. The same tools can be activated using the toolbar at the top of the Vertex Data Entry window. The Remove Recycle Stream is a toggle tool to switch between binary and ternary modes.

The Minor Components tool will bring up another data entry screen which allows the user to enter minor components found in the waste stream. Note: in binary mode only the waste stream is active; whereas, in ternary mode, both the waste and recycle streams can accept input.
## Select Constraints

Once you have filled out the Vertex Data Entry window, the next step is to determine which constraints to plot on the binary diagram and determine their values. This is done by opening the Constraint Selection window. This window is identical for either the binary or ternary cases. Like all of TWEAT's windows, it can be activated by selecting it from the Windows menu, shown here.

You select (or deselect) a particular constraint by clicking the mouse in the checkbox to the left of its name. An "x" in the box indicates that the constraint is selected. At the moment, two temperature levels are available. Either 1150 °C or 1350 °C can be used to calculate electrical conductivity or viscosity. (Depending on user feedback this may become a data input field so any temperature can be selected.) You can change the numerical value of any constraint by retyping the value, or by using the scroll bar. Two of the field Editing tools, Restore Field to Defaults and Restore Window to Defaults, are also active for the Constraint Selection window. Restore Vertex to Defaults does not make sense in this context.

<table>
<thead>
<tr>
<th>Constraint Selection Item in the Windows menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vertex Data Entry</td>
</tr>
<tr>
<td>Constraint Selection</td>
</tr>
<tr>
<td>Waste Stream Selection</td>
</tr>
<tr>
<td>Glass Properties Plot</td>
</tr>
<tr>
<td>Glass Composition Range Plot</td>
</tr>
<tr>
<td>Normalized Glass Composition Plot</td>
</tr>
<tr>
<td>Minor Components</td>
</tr>
<tr>
<td>Critical Solubility Constraints</td>
</tr>
<tr>
<td>OWL Property Comparison</td>
</tr>
<tr>
<td>Run Summary Report</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Constraint Selection</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Viscosity (Pa·s):Hi</td>
<td></td>
</tr>
<tr>
<td>Viscosity (Pa·s):Lo</td>
<td></td>
</tr>
<tr>
<td>Elec Cond(S/m):Hi</td>
<td></td>
</tr>
<tr>
<td>Elec Cond(S/m):Lo</td>
<td></td>
</tr>
<tr>
<td>B PCT(g/m·2)</td>
<td></td>
</tr>
<tr>
<td>B MCC(g/m·2)</td>
<td></td>
</tr>
<tr>
<td>Li PCT(g/m·2)</td>
<td></td>
</tr>
<tr>
<td>Li MCC(g/m·2)</td>
<td></td>
</tr>
<tr>
<td>Na PCT(g/m·2)</td>
<td></td>
</tr>
<tr>
<td>Na MCC(g/m·2)</td>
<td></td>
</tr>
<tr>
<td>TiIn (Spinel) °C</td>
<td></td>
</tr>
<tr>
<td>TiIn (Climopyroxene) °C</td>
<td></td>
</tr>
<tr>
<td>TiIn (Zr) °C</td>
<td></td>
</tr>
</tbody>
</table>

Recall: Selecting the OK button in the Vertex Data Entry window automatically brings up the Constraint Selection window.
context so that **Edit** menu item will be disabled.

Note that you **must** select at least one constraint - otherwise TWEAT has nothing to plot and you will not even be able to open the **Glass Properties Plot** window (which displays the binary diagram).

Generation of the binary diagram is automatic when you open the Glass Properties Plot window assuming you started from the two-stream vertex data entry window. You cause this to happen by either selecting the **Glass Properties Plot** item from the **Windows** menu or pressing the **OK** button on the **Constraint Selection** window. Note that neither option will be available if you have not selected at least one constraint.

After selecting the **OK** button you should see a binary diagram that looks something like the one below. **In binary mode TWEAT is really plotting properties as a function of waste fraction in the glass.** Technically results are upside down from what one would get by viewing a ternary diagram along the
waste-frit axis. The lines crossing the diagram are the constraints you selected in the Constraint Selection window. The value of the constraint everywhere along the plotted line is equal to the input value you provided (or the defaults, if you did not change them).

After the binary diagram has been created, you can easily move back to the Vertex Data Entry window or the Constraint Selection window to make changes. You can either click the mouse directly on your target window or make a selection from the Windows menu.

If you make changes in any window outside the binary diagram, an alert flag will warn you that the existing binary diagram no longer reflects the most current input information. The diagram can be updated immediately by selecting the Update Now button. You can get a last look at the previous binary diagram by selecting the Wait button. Whenever you want, you can update the diagram by selecting the Update Glass Properties Plot item in the Tools menu.

Whenever the binary diagram is the active window the Glass Properties Plot will show all of the supported constraints in the legend at the top of the window, but only those selected in the Constraint Selection window (or the Critical Solubility Constraints window) will have colored or patterned boxes in front of them.

The patterns are displayed when the current monitor is in black and white, otherwise TWEAT uses colors to distinguish between the selected constraints. The selected constraints will be followed by the numerical value of the constraint which was entered at the Constraint Selection window.
The legend boxes at the top of the binary diagram function as toggle switches so any particular constraint can be turned on or off. This is functionally equivalent to selecting constraints in the Constraint Selection window. Note that the numerical values for constraints cannot be changed directly from the Glass Properties Plot window. For that you must return to the Constraint Selection window.

Additional Tools

Several tools exist to increase or refine the information on the binary diagram. They are completely analogous to the tools for the ternary diagram and are accessed the same way(s).

The Shade Unacceptable Regions item in the Tools menu allows you to see which region of the binary diagram meets all of the constraint criteria. When you invoke the tool, each constraint is considered in sequence and the region of the binary which does
not meet that criterion is shaded. When all criteria have been considered, the unshaded white space in the diagram represents the acceptable region.

The **Shade Unacceptable Regions** tool lets you quickly determine which portion of the diagram meets all of the selected constraint criteria for the particular waste and frit you have chosen. In binary mode all constraints will show because shading is done after the constraint values to be plotted have been sorted. This is unlike the ternary shading algorithm where some properties are covered because shading is simply done according to the order at the top of the **Glass Properties Plot**.

The **Shade Unacceptable Regions** tool is a toggle tool. It will be checked in the menu if it is active and cleared if it is inactive. You should be able to tell its state by visually inspecting the diagram. You can unshade the unacceptable region by invoking the tool again when the diagram is already shaded. The result is a display of only the constraint boundaries as in our original figure.
Calculating Properties at a Point

The **Point Value Tool** allows you to select any point on the diagram (shaded or not) and generate a numerical value for each of the two vertices (i.e., waste and frit) plus values for all of the properties for which constraints have been selected. The numerical values appear in a floating palette that can be moved to any convenient location on the screen. Information stays on the floating palette until you click at another point or select another tool.

![Diagram showing the Point Value tool in action.](image)

The Point Value tool in action. Note the dot on the diagram. The information displayed on the floating palette describes the glass for that point.

The floating palette

---

**What's New 2-9**
Note that the values for waste and frit in the upper left-hand corner of the Glass Properties Plot window follow the mouse in real time. They will change as soon as you move the mouse again after you select a point. Once you do select a point, waste and frit fractions as well as the constraint values and glass composition are displayed on the floating palette. TWEAT also deposits a small black dot at the point on the diagram where you clicked the mouse. The point and the values displayed on the palette remain "frozen" until you select another point.

**Composition Boundaries**

All of the glass property models have been developed from experimental data. The experimental envelope continues to expand. Since it is experimentally impractical (and unnecessary) to test all components from 0 to 1 mass fraction, the models are valid only over a restricted composition space. With linear models it is easy, but generally not advisable, to extrapolate beyond experimentally tested compositions. TWEAT thus provides the user with feedback on where the property models are valid. This can be done with the **Overlay Experimental Boundaries** tool from the **Tools** menu.

The composition boundaries are shown with thick black lines on the binary diagram, as illustrated below:
When a point has been selected on the Glass Properties Plot, a Glass Composition plot can provide useful information in terms of where we are within our experimental database. In binary mode, the thin horizontal line identifies the point of the mouse click (or the OWL import point). Wherever the line crosses a composition bar, the point is outside our experimental limits for that oxide. White space is within the limits.

The Glass Composition Range Plot window is only available when you have selected a data point, and it is valid only for that one point. This plot for the binary system is different from the one for the ternary system. The binary version normalizes all limits to some fraction of the waste stream. Presenting data this way is useful for guiding the OWL runs because it shows which limit will hit next. Users and readers are cautioned that you can NOT assume bars in the upper part of the window represent upper limits. Which limit is which (upper or lower) depends on the ratio of a particular component in the frit to that in the waste. Numerical values in the floating palette are backup indicators as to which limits are actually being approached. If you would like to know which experimental limit is represented by any portion of the experimental limit rectangle, simply select a data point just barely
Silica and sodium are beyond limits for the point chosen (i.e. NCAW = .1897 and Frit = .8103)

<table>
<thead>
<tr>
<th>Values</th>
<th>0.1897</th>
<th>0.8103</th>
</tr>
</thead>
</table>

--- Constraint Values @ Pt ---

- Viscosity (Pa·s): = 11.18
- Elec Cond(S/m): = 19.48
- B PCT(μm²): = 1.46
- Li PCT(μm²): = 1.47
- Na PCT(μm²): = 0.73
- Thq (Spinel) °C = 917.0
- Thq (Climopiroxene) °C = 833.5
- Thq (Zr) °C = 878.5

--- Glass Composition ---

- SiO₂ = 0.596<<exp limit
- B₂O₃ = 0.159
- Na₂O = 0.040<<exp limit
- Li₂O = 0.035
- CaO = 0.001
- MgO = 0.000
- Fe₂O₃ = 0.055
- Al₂O₃ = 0.017
- ZrO₂ = 0.028
- others = 0.047

As a final note, be aware that some of the glass components are frequently present in such small quantities that they do not create a visible bar on the small chart.
Most menus in TWEAT '95 have changed either in looks or in order of operations or in shortcut keys used for various selections. The lone exception is the Edit menu which remains the same. The changes were made to group operations in a more logical sequence for the user.

The Apple Menu

Displays the TWEAT splash screen (aka the credits, or "the bird" screen).
Opens and activates TWEAT's on-line help system.
Closes all open windows and resets TWEAT to its default state.
Opens a data file previously saved from TWEAT.
Closes the topmost window.
Saves the contents of the Vertex Data Entry window, Constraint Selection window, Minor Components window, and Critical Solubility Constraint window to disk.
Saves the current data file under a different name.
Saves the topmost Window as a PICT image file.
 Imports data from the Optimal Waste Loading environment (OWL).
Imports tab delimited data for the Vertex Data Entry window from spreadsheets, database, etc.
Activates the page setup dialog for the current printer.
Prints the topmost window.
Closes all windows and exits the application.

The File Menu

New
Open...
Close
Save
Save As...
Save as PICT...
Import OWL Data...
Import Tab Data...
Page Setup...
Print
Quit

Menu Reference 3-1
### The Edit Menu

<table>
<thead>
<tr>
<th>Item</th>
<th>Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Can't Undo...</td>
<td>%Z</td>
</tr>
<tr>
<td>Cut</td>
<td>%K</td>
</tr>
<tr>
<td>Copy</td>
<td>%C</td>
</tr>
<tr>
<td>Paste</td>
<td>%V</td>
</tr>
<tr>
<td>Clear</td>
<td></td>
</tr>
<tr>
<td>Select All</td>
<td>%A</td>
</tr>
<tr>
<td>Revert Field to Defaults</td>
<td>%F</td>
</tr>
<tr>
<td>Revert Column to Defaults</td>
<td></td>
</tr>
<tr>
<td>Revert Window to Defaults</td>
<td>%Y</td>
</tr>
</tbody>
</table>

### Preferences...

If an undoable action has just occurred (e.g., a Cut operation in an edit field) this item changes to Undo. It will reverse the effects of the last operation.

- Deletes currently selected text but keeps a temporary copy of it on the clipboard.
- Copies current text selection to the clipboard.
- Pastes the clipboard text into the current edit field starting where the cursor is located.
- Deletes current text selection without copying it to the clipboard.
- Selects all of the text in the current edit field.
- Reverts contents of current field to its original default value.
- Reverts contents of all edit fields in the current column to defaults (applies to Uertex Data Entry window only).
- Reverts all edit fields in the current window to defaults (Uertex Data Entry and the Constraint Selection windows only).

Not implemented in TWEAT '94 or TWEAT '95.

### The Windows Menu

Each menu item opens the window of a similar name. See the Window Reference (next chapter) for a description of each window. Notice the short-cut keys have changed from TWEAT '94.

<table>
<thead>
<tr>
<th>Windows</th>
<th>Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vertex Data Entry</td>
<td>%1</td>
</tr>
<tr>
<td>Constraint Selection</td>
<td>%2</td>
</tr>
<tr>
<td>Waste Stream Selection</td>
<td>%3</td>
</tr>
<tr>
<td>Glass Properties Plot</td>
<td>%4</td>
</tr>
<tr>
<td>Glass Composition Range Plot</td>
<td>%5</td>
</tr>
<tr>
<td>Normalized Glass Composition Plot</td>
<td>%6</td>
</tr>
<tr>
<td>Minor Components</td>
<td>%7</td>
</tr>
<tr>
<td>Critical Solubility Constraints</td>
<td>%8</td>
</tr>
<tr>
<td>OWL Property Comparison</td>
<td>%9</td>
</tr>
<tr>
<td>Run Summary Report</td>
<td>%0</td>
</tr>
</tbody>
</table>

For ternary case only

For binary case only

3-2 TWEAT
The Tools Menu

The Tools menu has been modified for clarity. Both the Vertex Data Entry window and the Glass Properties Plot have a cascading sub-menu.

Sums compositions in a vertex in Vertex Data Entry window.

Adjusts all fields in a vertex such that sums equal 1.0000.

Adjusts 'Other Oxides' such that vertex sums to 1.0000.

Toggles between binary and ternary mode.

Menu Reference 3-3
Increases the magnification of the Glass Properties Plot.

Decreases the magnification of the Glass Properties Plot.

"Grabs" and scrolls the Glass Properties Plot.

Returns Glass Properties Plot to 100% and centered.

"Grabs" and scrolls the Glass Properties Plot.

Displays limits of experimental data on Glass Properties Plot.

Toggles shading of unacceptable region on Glass Properties Plot.

Toggles point plotting on Glass Properties Plot with mouse.

Displays composition uncertainty on Glass Properties Plot (not implemented in TWEAT '95).

Displays model uncertainty on Glass Properties Plot (not implemented in TWEAT '95)

Forces recalculation and drawing of Glass Properties Plot.

The Help Menu (System 7.x Only)

Displays description of balloon help (provided by operating system).

Turns on Balloon Help (provided by operating system).

Turns on TWEAT Help System (provided by TWEAT).
4.0 Window Reference

The "About" Window, aka Credits Screen

The *About* window is simply the title screen. It also credits the organizations responsible for TWEAT, namely Pacific Northwest Laboratory and Ariel Publishing, Inc.

The Vertex Data Entry Window

The *Vertex Data Entry* window allows users to input source stream compositions. Data can be entered by hand, imported from OWL, cut and pasted from most spreadsheets, or imported from tab delimited text files.
Binary Vertex Data Entry window

Toolbar functions are the same as for the ternary Vertex Data Entry window.

![Vertex Data Entry: Untitled](image)

Revert back to ternary Vertex Data Entry window.

<table>
<thead>
<tr>
<th>Component</th>
<th>Vt. Frac. as Oxide</th>
<th>Component</th>
<th>Vt. Frac. as Oxide</th>
</tr>
</thead>
<tbody>
<tr>
<td>SiO₂</td>
<td>0.7356</td>
<td>SiO₂</td>
<td>0.0040</td>
</tr>
<tr>
<td>B₂O₃</td>
<td>0.1963</td>
<td>B₂O₃</td>
<td>0.0001</td>
</tr>
<tr>
<td>Na₂O</td>
<td>0.0000</td>
<td>Na₂O</td>
<td>0.2142</td>
</tr>
<tr>
<td>Li₂O</td>
<td>0.0681</td>
<td>Li₂O</td>
<td>0.0000</td>
</tr>
<tr>
<td>CaO</td>
<td>0.0000</td>
<td>CaO</td>
<td>0.0079</td>
</tr>
<tr>
<td>MgO</td>
<td>0.0000</td>
<td>MgO</td>
<td>0.0020</td>
</tr>
<tr>
<td>Fe₂O₃</td>
<td>0.0000</td>
<td>Fe₂O₃</td>
<td>0.2821</td>
</tr>
<tr>
<td>Al₂O₃</td>
<td>0.0000</td>
<td>Al₂O₃</td>
<td>0.0004</td>
</tr>
<tr>
<td>ZrO₂</td>
<td>0.0800</td>
<td>ZrO₂</td>
<td>0.1511</td>
</tr>
<tr>
<td>Other Oxides</td>
<td>0.0000</td>
<td>Other Oxides</td>
<td>0.2482</td>
</tr>
</tbody>
</table>

4-2 TWEAT
Constraint Selection Window

The **Constraint Selection** window allows the user to select which property constraints to plot in the **Glass Properties Plot** window (i.e., either the binary or the ternary diagram).

Glass Properties Plot

The **Glass Properties Plot** displays either the binary or the ternary diagram showing the constraint lines selected in the **Constraint Selection** window. The **Tools** menu has many options that change what is displayed in this window. Note that the value of each constraint and the identifying pattern or color are displayed at the top of the window.
The binary Glass Properties Plot uses the same identifying color/pattern for each property as does the ternary version.

Glass Composition Range Plot

The Glass Composition Range Plot displays a color or pattern encoded bar for each glass component at a selected point on the ternary diagram. If the composition is well within experimental limits, the bar is encoded green. If it is close to a limit, it is encoded yellow, and if it is beyond the limit, it is encoded red.
The binary version of this plot is quite different. Here all results are normalized to waste loading. This visualization makes it easier for OWL users to spot which limit is likely to hit next (i.e. limit waste loading.) The final version of TWEAT '95 will identify upper and lower bounds numerically.

The Floating Data Palette

The Floating Data Palette is only open when you are plotting points on the Glass Properties Plot with the mouse. It displays the values of the selected constraints at the point as well as the composition of the glass.

The Floating Critical Solubility Constraint Palette

This data palette is open only when you have selected critical solubility constraints and have selected the Crit button in the upper right hand corner of the main Floating Data Palette shown above. The Critical Solubility Constraint Palette shows the values of the selected critical component compositions at the current data point.
The Type Z Values Window

The Type Z Values window allows users to specify exact Z coordinates for a data point on the Glass Properties Plot. (Only Z1 and Z2 show for the binary case.) The Update Now button plots the point and recalculates the appropriate diagram.

Minor Components Window

The Minor Components window is where the user can specify minor component compositions of a given waste or recycle stream. These compositions must sum to a number ≤ the Other Oxides for the waste and recycle vertices in the Vertex Data Entry window.

This window is only available in the Windows menu when the Vertex Data Entry window is the active window. For the binary case, only the waste stream is active.

Critical Solubility Constraint Selection

The Critical Solubility Constraints window exists to allow users to select which critical solubility constraints to plot on the Glass Properties Plot and at what limiting value.

This window is only available in the Windows menu when the Constraint Selection window is the active window.
The Run Summary Report

Although primarily designed as a permanent, hard copy record of a TWEAT session, the Run Summary report is nevertheless placed into a scrolling, resizable window for previewing.

The Run Summary report does not require any user interaction. Instead, it displays the current data sets in tabular format and also reproduces the Glass Properties Plot and the Glass Composition Range Plot in miniature. TWEAT knows whether the report is for a binary or ternary run.

The On-line Help System

TWEAT's on-line help system allows you to select a help topic in the scrolling list on the left, and then read a brief description of the topic in the information area on the right.

Run Summary Annotation Window

This window allows users to place custom text on the Run Summary report. This is often useful to highlight details, point out problems, etc.
The Estimated Model Variances Window

This feature is temporarily disabled in TWEAT '95. The plan is to recode the calculations after the general order plotting routines on the ternary diagram have been completed.

Estimated Model Variances


[4.1]

Show Error

Cancel

This window appears when you select Plot Model Error from the Tools menu. It requests the F Statistic Multiplier, a statistical multiplier based on the number of coefficients used in the model and the number of observations used to determine the coefficients. Most users will simply want to accept the default value shown in the window. For TWEAT '94 and '95, the value is 4.1. The F Statistic Multiplier will change to a vector of values in future versions of TWEAT.

OWL Property Comparison Window

Recall a "normal" window here would show identical numbers in the OWL and TWEAT columns.

This window is only available when you have imported OWL data. It allows you to compare OWL's values for the selected constraints at the solution point with those computed by TWEAT for the same point. For the binary case Recycle is omitted. Its sole purpose is to spot discrepancies between the TWEAT and OWL property models.
5.0 Reference

Appendix A: Property Models

Property Model Formulations
The table on page A-4 shows the mixture model coefficients used to predict various glass properties. The coefficients are based on CVS data up through CVS-II Phase 3 data (Hrma et al. 1994). The linear mixture models express some transform of the property as a function of mass fraction of nine specific oxides plus a general category of "other oxides." These fitted property models are quite preliminary, and have statistically significant lack-of-fits in some cases as discussed in reference 1.

The linear equations (applicable to the 3 liquidus temperatures) are of the form:

\[ P_j^* = \sum_{i=1}^{n} C_{ij} \cdot g_i \]

Where: \( P_j^* \) is the transform of property \( P_j \)

\( C_{ij} \) is the coefficient of the \( i^{th} \) component for the \( j^{th} \) property

\( g_i \) is the weight fraction of component \( i \) in the glass mixture

The calculation of \( g_i \) is as follows:

\[ g_i = (f_i \cdot F + w_i \cdot W + r_i \cdot R) / (W + F + R) \]

Where: \( f_i \) = weight fraction of component \( i \) in the frit

\( F \) = weight fraction of frit in the glass mixture

\( w_i \) = weight fraction of component \( i \) in the waste stream

\( W \) = weight fraction of waste in the glass mixture

\( r_i \) = weight fraction of component \( i \) in the recycle stream

\( R \) = weight fraction of recycle stream in the glass mixture

By convention, \( W + F + R \) must sum to 1.0000
The equation for electrical conductivity is the Arrhenius equation in the form:

\[ \varepsilon^* = \sum_{i=1}^{10} A_i \cdot g_i + \frac{\sum_{i=1}^{10} B_i \cdot g_i}{T} \]

where \( T \) is in degrees Kelvin
\( A_i \) and \( B_i \) are coefficients

The Fulcher model for viscosity is:

\[ \tau^*_T = \sum_{i=1}^{10} A_i \cdot g_i + \frac{\sum_{i=1}^{10} B_i \cdot g_i}{T - \sum_{i=1}^{10} T_i \cdot g_i} \]

where \( A_p, B_p \), and \( T_i \) are constants
\( T \) is in degrees Celsius

The release rate equations (both Product Consistency Test [PCT] and Materials Characterization Center [MCC]) are cast in Scheffe's second order models in the form:

\[ R_i^* = \sum_{i=1}^{10} a_i \cdot g_i + \sum_{i=1}^{9} \sum_{j=i+1}^{10} b_{ij} \cdot g_i \cdot g_j \]

where \( a_i \) is the coefficient corresponding to the first order term in \( g_i \)

\( b_{ij} \) is the second order term involving \( g_i \) and \( g_j \)
The property inverse transforms are:

\[ T_{\text{liq}} = \text{liquidus temperature (°C)} \]

\[ T_{\text{liq}} = T^*_{\text{liq}} \text{ for spinel, clinopyroxene, and Zr-containing crystals.} \]

\[ n_T = \text{viscosity (Pa*s) at } T \text{ °C} \]

\[ n_T = \exp(n^*_T) \]

\[ \epsilon_T = \text{electrical conductivity (S/m) at } T \text{ °K} \]

\[ \epsilon_T = \exp(\epsilon^*_T) \]

\[ R_i = \text{release rate (gm/m}^2\text{-28day for MCC and gm/m}^2\text{-7day for PCT)} \]

\[ R_i = \exp(R^*_i) \]
## Coefficients for Property Models

| Property coefficients were electronic copies out of PNL-10359 Vols 1 & 2. *Property/Composition Relationships for Hanford High-Level Waste Glasses Melting at 1150 °C*, report by Hima, Pospel et al. December 1988 |

<table>
<thead>
<tr>
<th>SK2</th>
<th>B203</th>
<th>NA2O</th>
<th>Li2O</th>
<th>CO2</th>
<th>MED</th>
<th>FE2O3</th>
<th>Al2O3</th>
<th>SiO2</th>
<th>OTHERS</th>
</tr>
</thead>
<tbody>
<tr>
<td>A1</td>
<td>A2</td>
<td>A3</td>
<td>A4</td>
<td>A5</td>
<td>A6</td>
<td>A7</td>
<td>A8</td>
<td>A9</td>
<td>A10</td>
</tr>
<tr>
<td>Fulcher</td>
<td>B1</td>
<td>B2</td>
<td>B3</td>
<td>B4</td>
<td>B5</td>
<td>B6</td>
<td>B7</td>
<td>B8</td>
<td>B9</td>
</tr>
<tr>
<td>T in °C</td>
<td>12265.3263</td>
<td>15922.8410</td>
<td>-12965.4177</td>
<td>-39177.2042</td>
<td>-18871.4525</td>
<td>-11943.9811</td>
<td>14559.3344</td>
<td>9524.4389</td>
<td>4618.1457</td>
</tr>
<tr>
<td>T in °C</td>
<td>76.1127</td>
<td>263.4848</td>
<td>425.7163</td>
<td>474.4299</td>
<td>1065.8248</td>
<td>752.2421</td>
<td>43.6384</td>
<td>178.5252</td>
<td>549.5088</td>
</tr>
<tr>
<td>Arrehnius</td>
<td>B1</td>
<td>B2</td>
<td>B3</td>
<td>B4</td>
<td>B5</td>
<td>B6</td>
<td>B7</td>
<td>B8</td>
<td>B9</td>
</tr>
<tr>
<td>T in °K</td>
<td>-10283</td>
<td>-18135</td>
<td>7088.47558</td>
<td>22848</td>
<td>-18769</td>
<td>-13444</td>
<td>-10608</td>
<td>-8227.1802</td>
<td>-9723.8607</td>
</tr>
</tbody>
</table>

| 2nd order | b8:8=Al, A1 | b2:2=B, B | b1:8=Sl, MG | b3:8=NA, CA | b2:5=B, CA | b8:8=MG, ZR |

| 2nd order | b8:8=Al, A1 | b2:2=B, B | b8:8=MG, A1 | b3:5=B, CA | b5:8=NA, CA | b3:8=NA, AL | b7:8=FE, A1 |

| PCT NA | -2.57611 | -10.564239 | 15.24801 | 4.552698 | 7.532897 | -30.222826 | -1.307042 | -34.026706 | -5.218646 | 2.496056 |
| 2nd order | b1:8=Sl, MG | b2:8=B, CA | b8:4=NA, LI | b2:2=B, B | b4:6=LI, MG | b8:8=Al, A1 |

| 2nd order | b8:8=Al, A1 | b2:8=B, B | b1:8=Sl, CA | b3:5=CA, CA | b3:8=NA, MG |

| UO2/PINEL | C1 | C2 | C3 | C4 | C5 | C6 | C7 | C8 | C9 | C10 |
| Linear | 989.305474 | 686.419006 | 9772076 | -128.772539 | 1366.211945 | 2830.582448 | 2258.0913 | 1735.02572 | 928.109425 | 1005.5533 |

| UO2/RC | C1 | C2 | C3 | C4 | C5 | C6 | C7 | C8 | C9 | C10 |
| Linear | 753.776337 | 1095.63041 | 74.318313 | -958.393494 | 886.7838 | 2458.487726 | 1461.03907 | 1338.08107 | 4541.99413 | 657.984105 |

| UO2/NO | C1 | C2 | C3 | C4 | C5 | C6 | C7 | C8 | C9 | C10 |
| Linear | 955.648709 | 314.718016 | 38.828089 | -207.052312 | 1372.457773 | 2387.819245 | 1508.86728 | 1319.78139 | 1844.50102 | 1357.40445 |
The correspondence between data in the table and the model equations is fairly obvious. The order of glass components is always the same. Thus A, or a, always refer to SiO₂ and A, or b, always refer to CaO. The coefficients are the same in the model equations as in the table with the exception of the Scheffe' second order models. The nomenclature in the table is an attempt to clarify which oxides are being used. Thus b1:6=Si_MG for PCT B release model means coefficient b (117.171887) is to be multiplied by the product of the 1st and 6th oxides which are SiO₂ and MgO respectively. The b coefficients which are not defined are simply 0.0.